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ABSTRACT

Voice is utilized in this project for control switches. Reason for selecting voice is because
it's simply being reproduced by human. Besides that, usage of voice provides a bearing
system which will be effective and convenient to be used. The applying of this technique
involve modifying the switch system from the normal approach that is physical contact
with the switch to a safer approach wherever the usage of voice to exchange all the
physical contact. Home automation is building automation for a home, called a smart
home or smart house. It involves the management and automation of lighting, heating,
ventilation, air con, and security, also as home appliances like ovens or
refrigerators/freezers. There square measure completely different strategies in wireless
technology like Bluetooth, WIFI, and GSM. During this paper, new style and completely
different home appliances square measure bestowed. The home automation application
that has presented in this paper is the ability to control the bulb using a smart phone
application with Bluetooth wireless technology. The relays is used to connect these
appliances to the input/ output ports of the board .The design is a low cost, flexible and
using a modern technology and devices for this application. Application of wireless
Bluetooth connection in control board enables a simplified way to system installation.

The system has been built and operated successfully.

©Daffodil International University



CHAPTER 1
INTRODUCTION

1.1 INTRODUCTION

Home automation permits controlling house appliances like door, light, fan, oven etc. It
conjointly provides associate emergency system and residential security. It allows the
consumer additional control of his home it facilitates several conditions, as an example, if
the consumer is permit to on his home appliance to controlled light, fan or any other load,
or pre-heating kitchen appliance once he got home, therefore, several manual actions is
replaced by home automation that reduces human efforts and time-saving. During this
paper, new style and totally different home appliances are given. Many different electric
applications is controlled by using Arduino UNO Microcontroller Based Home
Automation System. The system is used to bulb using a smart phone application with

Bluetooth wireless technology.

1.2 AIM OF THE PROJECT

= For the house automation system by associate Android application.

= Setup a primarily based microcontroller automation system.

= Change devices and appliances through the electrical device module.
= Style a correct circuit diagram.

= Implement the planning.

1.3 SCOPES

= Without cost home automation system project to make easy daily life works in
millions of houses.

= |t can be used commercially in industries.

=  Portable Android application to use it frequently in hand.

= Bluetooth technology which might be utilized in wireless affiliation for cellular

phones and residential appliances. Bluetooth technology offers associate

©Daffodil International University



economical methodology for dominant home automation. It’s an occasional value
and a secured technology.

= Several relays use associate magnet to automatically operate the switch and
supply electrical isolation between 2 circuits. During this project there ought to
isolate one circuit from the opposite, however we are going to use associate

ArduinoUNO to regulate the relay.

1.AMETHODOLOGY

This system is used to control all the appliances that connected to the microcontroller.
The methodology of the proposed system is mainly divided into the three steps. In the
initial step an Android application interfaces with the Bluetooth module. After that within
the second step, the microcontroller receives the signal that has been causing by the
Bluetooth module. Then microcontroller sends the activation signal to the relay module.
In the last step relay module switches the devices that connected to the relay.

1.5 ORGANIZATION OF THE REPORT

This project report has seven chapters in total. The first chapter describes an idea about
our project“Voice Control Home Automation”, Brief description of the project, scopes
and methodology. The second chapter about history, block diagram, circuit diagram, list
of components. The chapter third about component description, cost analysis of our
system.The chapter fourth software analysis &program explanation. The chapter five
hardware implementation. Then chapter sixdescribes result & discussion properly.
Finally, chapter seven gives the concluding remarks, limitation of our systemand

suggestion for the future works.
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CHAPTER 2
SYSTEM REVIEWS

2.1 INTRODUCTION

The home automation system permits people to regulate home appliances by using a
sensible phone application. It’s necessary to appear on hardware and users good phone
software for developing a home automation system. The product can deal with many
home appliances such as lights, door lock etc.In this chapter we will discuss about
Bluetooth module (HC-05), Relay module and ArduinoUNO, ‘Automation Smart Home’
apps, Arduino compiler, Block diagram & circuit diagram of our System.

2.2 GENERAL BLOCK DIAGRAM

-=== ()

Bluetooth
User

|
Il

LTI

Appliance
b

I
LI

']
Power Supply

= mm == wp Wireless Connection

LCD Display - Vired Connection

i

Fig. 2.1 General Block Diagram
2.2.1 BLOCK DIAGRAM DESCRIPTION

The block diagram of home automation system as shown in fig.2.1, is using the
ArduinoUNO, we can operate the Bluetooth module, relay module. When the dedicated
command is available, then Bluetooth module (HC-05) sends a digital output to control
unit. At this time the control units (ArduinoUNO) will send commands to relay module to
switching ON/OFF.

©Daffodil International University



2.3 CIRCUIT DIAGRAM
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2.3.1 WORKING PROCESS OF OUR CIRCUIT

The Voice Control Home Automation project operated by a free application known as
“ARDUINO BLUETOOTH CONTROLLER”. This application operate the various
appliances attached to our ArduinoUNO and relays.Once the toggle switch on the
applying are press, corresponding Bluetooth signals are transfer data from our android
cell phone to the Bluetooth module we've attached to our Arduino. The Arduino finds out
that the signal was sent and compares it to the predefined signals appointed for every
appliance. Once it recognize that signal, the Arduino turn on the relay connected to its
digital pin by carrying out 5V through it.Thus the relay is turn on and also the similar
appliance connected to the relay is turned onexactly same way. To turn it OFF, Arduino
UNO transfer OV or logic low to its digital pin.

24LIST OF COMPONENTS USED IN CIRCUIT

NO COMPONENT NAME QUANTITY USED

01 Bluetooth Module (HC-05) 01 To direct communication.

02 Microcontroller- 01 To Control the System.
ATmega328P(ArduinoUNO)

03 Relay Module 01 To switching.

04 Arduino compiler To compile code.

04 Arduino voice control app 01 To giving command.

06 Ac to dc power supply 02 Power Supply

07 LCD Display 19 Showing Text

09 Load 03 Showing Output.

Table 2.1 list of component we used

2.5 CONCLUSION

The home automation system which used in many applications because of its desirable

properties like homes, hostels, industries, vehicles.
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CHAPTER 3
COMPONENT DESCRIPTION

3.1 INTRODUCTION

System hardware design composed of Arduino UNO, 4 Channel 5V Relay Module,
Bluetooth Module (HC-05),Wires, Arduino compiler, Android application. In this chapter
we will discuss about component description, features, working procedure and cost

analysis of our all component.

3.2 DESCRIPTION OF BLUETOOTH MODULE (HC-05)

Nowadays, everything goes wireless. Phones, computers, game controllers, everything.
Wireless technology has allowed us to use electronic devices with AN unbound freedom
that simply is not possible with awkward cables hanging off our device.There are several
kinds of wireless property like Wi-FI, Cellular Data, Zigbee, however, one among the
foremost in style and wide used wireless protocols is Bluetooth. Whilst the Bluetooth HC-
5 standard was declared earlier this year (2018), we’ll be taking a look at using the

Bluetooth 4.2 standard because it is most typically on the market at the instant.

Fig 3.1 Logo of Bluetooth.
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HC-05 module is a simple to utilize Bluetooth SPP (Serial Port Protocol) module,
intended for straightforward remote sequential association setup. The HC-05 Bluetooth
Module can be utilized in a Master or Slave setup, making it an incredible answer for
remote correspondence. This sequential port Bluetooth module is completely qualified
Bluetooth V2.0+EDR (Enhanced Data Rate) 3Mbps Modulation with complete 2.4GHz
radio handset and base band. It utilizes CSR Blue-center 04-External single chip
Bluetooth framework with CMOS innovation and with AFH (Adaptive Frequency
Hopping Feature).The Bluetooth module HC-05 is a MASTER/SLAVE module. As a
matter of course the processing plant setting is SLAVE. The Role of the module (Master
or Slave) can be designed just by AT COMMANDS. The slave modules can't start an
association with another Bluetooth gadget, however can acknowledge associations. Ace

module can start a connection with different gadgets.

VCC:3.6—86V
BT BOARD V104

Fig. 3.1.1 Bluetooth Module (HC-05)
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3.2.1FEATURES OF BLUETOOTH MODULE (HC-05)

FEATUREOF HARDWARE

= Typical -80dBm sensitivity.

= Up to +4dBm RF transmit power.

= 3.3t0 5V Input/Output.

= PIO (Programmable Input/Output) control.
= With integrated antenna.

= With edge connector.

FEATURE OF SOFTWARE

= DefaultData bits 8, Stop bit 1,Baud rate 9600, Parity No parity.
= Automatically connect to the last device when power on.

= Automatically connect with paired device

= Default PINCODE is “1234” or auto-pairing.

3.2.2 PIN DESCRIPTION OF HC-05

VCC:3.6—6V &—=GNDA"

BT BOARD V1.04 *—VCC™
= ——KEY

Fig 3.1.2 Pins of HC-05.
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SL. PIN NAME DESCRIPTION

1 +5V or 3.3V +5V supply or Power Pin.

2 TX The Data/Command to be trgnsmitted is sent through this
pin.

3 RX The Received data is read from this pin.

4 KEY/EN Input pin, which alters module between the Data mode and

the AT Command mode.

5 STATE Output pin, the state of the module is indicated through this
pin.
6 GROUND 0V / GND or Power Pin

Table 3.1 Pins Description of Bluetooth Module

3.2.3SUMMARY

In the end this is a very good device to use in home or industry. This is a low cost project
so that it is very cost effective and efficient. In short term uses of communication it is

better than other wireless communication.

3.3 Basic Description of Android Application

An android application could be a product framework application running on the android
stage. Since the android stage is developed for cell phones, a run of the mill android
application is intended for an advanced mobile phone or a tablet PC running on the
android OS. Despite the fact that an android application will be made available by
designers through their sites, most android applications are transferred and distributed on
the android Market, a web store devoted to those applications. The android Market
choices each free and estimated applications. Golem applications are composed inside the
Java programing dialect and use Java center libraries. They're first assembled to Dalvik
executable to keep running on the Dalvik virtual machine that is a virtual machine
exceptionally intended for cell phones. Designers may exchange the golem PC code
improvement pack (SDK) from the android site. The SDK incorporates apparatuses, test

code and important records for making android applications.
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3.3.1 ARDUINO VOICE APPLICATION

= HOME ¥} VOICE CONTROL

TERMINAL
) >onn
@ Turn OFF

Arduin > Ledd on
Arduir edd of
Button Button 2
>
mf:; ‘))) how to Sala or
12 3 45 6 7 8 90

REMOTE
CONTROLLER

gwer tyuiop
TIMER ajsjdiflajhfijk}!
26 Button 3 Button 4 iz)xjcjviblnimpe

He

Enghsh (UK] e

Fig 3.2 Home page of Android Apps.

3.4 BASIC DESCRIPTION OF COMMEND UNIT

In the commend unit, we are using Arduino equipment board (with AVR
microcontroller). With the assistance of Arduino 1.6.8 software system we are able to
simply program AVR IC, as our requirement. Arduino is an open-source electronics
prototyping platform supported versatile, easy-to-use hardware and software system. It's
meant for artists, designers, hobbyists, and anyone fascinated by making interactive
objects or environments. The microcontroller on the board is programmed exploitation
the Arduino artificial language (based on Wiring) and also the Arduino development
setting (based on Processing). The Arduino UNO could be a microcontroller board
supported the ATmega-328. Fourteen digital 1/0 pins in this device (which half-dozen
will be utilized as Pulse width modulation outputs), Six analog inputs, A 16 MHz ceramic
resonator, a USB port, an impact jack, an ICSP header, and a reset push. It contains
everything required to support the microcontroller, easily connect it to a laptop with a

USB link or power it with an AC-to-DC adapter or battery to begin.
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3.4.1 TECHNICAL SPECIFICATION ARDUINO UNO

Fig 3.3(a) ArduinoUNO.

Microcontroller
Operating Voltage
Supply Voltage
(recommended)

Maximum supply voltage
(not recommended)

Digital INPUT/OUTPUT

ATmega328
5V
7-12V

20V

Fourteen (of which six provide PW

Pins output)
Analog Input Pins Six
DC Current per 40 Ma
INPUT/OUTPUT Pin

DC Current for 3.3V Pin 50 mA

Flash Memory 32 KB (ATmega328) of which 0.5
utilized by boot loader
SRAM 2 KB (ATmega328)

Table 3.2 Technical specification of ArduinoUNO
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3.4.2 DESCRIPTION OF MICROCONTROLLER ATmega328

Digital Ground
Digital | /0 Pins (2-13)
|

Serial Out (TX)
Serial In (RX)

Analog Reference Pin

USB Plug —
Reset Button

In-Circuit
Serial Programmer

ATmega328
Microcontroller

External Power Supply

......

Reset Pin
3.3 Volt Power Pin
5 Volt Power Pin

Analog In
Pins (0-5)

Ground Pins

Fig 3.3(b) ArduinoUNO.

The Arduino UNO could be a microcontroller board supported the ATmega-328
(Datasheet). Fourteen digital 1/0O pins in this device (which half-dozen will be utilized as
Pulse width modulation outputs), Six analog inputs, A 16 MHz ceramic resonator, a USB
port, an impact jack, an ICSP header, and a reset push. It contains everything required to
support the microcontroller, easily connect it to a laptop with a USB link or power it with
an AC-to-DC adapter or battery to begin. The UNO varies from every previous board in
that it doesn't utilize the FTDI USB-to-serial driver chip. Rather, it includes the
Atmega328 modified as a USB-to-sequential converter. "UNO™ means "One" in Italian
and is called to mark the upcoming release of Arduino 1.0. The UNO and version 1.0 are
going to be the reference from of Arduino, moving forward. The UNO is that the latest in
an exceedingly series of USB Arduino boards and also the reference model for the
Arduino platform; for a comparison with previous versions, see the index of Arduino
board.
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3.4.3BLOCK DIAGRAM OF MICROCONTROLLER - (ATmega328)

PAT.0 PB7.0
Vet [y A
r-—--—----r—=-=-—-=-=-"1-"=—-=-=-== 1
Power y |
. Supervision
RESET —— 508 /BOD & PORT A (8) PORTB(8) [,
RESET |
i
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\ Y
= | Walchdog | o |
Gl Tmer | 7
| 1 ) ) ‘ ‘
Walchdog AD Analog NN
Oseillator Converter Comparator | P [ USARTO
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XTAL1 | Y T—‘ f |
fr 1
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— D | Creuits/ | EEPROM Bandgap reference S A |
- Clack
ﬁ Generation
L XTAL2 [ ‘
. BiTCO [
| P\ 2 |
| | oo | I BOUTC 1 fe—b |
| N My et |
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Fig. 3.3.1Block Diagram ofMicrocontroller — (Atmega328)
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3.4.4 PIN CONFIGURATIONS OF MICROCONTROLLER
(ATmega328)

Yot
(PCINT14/RESET) PC6 [] 1 28 | 1 PC5 (ADC5/SCL/PCINT13)
(PCINT16/RXD) PDO [} 2 27 | 1 PC4 (ADC4/SDA/PCINT12)
(PCINT17/TXD) PD1 [} 3 26 | 1 PC3 (ADCS3/PCINT11)
(PCINT18/INTO) PD2 [] 4 25 [ 1 PC2 (ADC2/PCINT10)
(PCINT19/0C2B/INT1) PD3 [} 5 24| 1PC1 (ADC1/PCINT9)
(PCINT20/XCK/T0) PD4 [] 6 23| 1 PCO (ADCO/PCINT8)
vCC [}7 22 | 1GND
GND []8 21 11 AREF
(PCINT6/XTAL1/TOSC1) PB6 ]9 20 [ JAvCC

)
(PCINT7/XTAL2/TOSC2) PB7 [
(PCINT21/0C0B/T1) PD5 [

)

)

)

-t
o

19 |1 PB5 (SCK/PCINTS)
18 |1 PB4 (MISO/PCINT4)
17 1 PB3 (MOSI/OC2A/PCINT3)

—
—r

(PCINT22/0OCOA/AINO) PD6 L}
(PCINT23/AIN1) PD7 [
(PCINTO/CLKO/ICP1) PBO L

ek
w N

16 [ PB2
15 |1 PB1

SS/OC1B/PCINT2)
OC1A/PCINTH1)

—
S
A~

Fig. 3.3.2Pin Configurations ofMicrocontroller — (Atmega328)

3.4.5 PIN DESCRIPTIONS

The underneath gives a depiction for every one of the pins, alongside their capacity-

The four pins are as below:

» VIN:The input voltage to the Arduino board when it's utilizing an external power
supply (as against five volts from the USB association or another regulated power
source). We are able to provide voltage through this pin, or, if supply voltage via
thepower jack, access it through this pin.

* 5V:The regulated power supply utilize to power the microcontroller and

different elements on the board. This will come back either from VIN via an on-board
regulator, or be provided by USB or another regulated 5V supply.

* 3.3V:A 3.3V supply generated by the on-board regulator. Highest current draw is 50
mA.

* GND (Ground pins)
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Input & Output of Arduino UNO

Each of the fourteen digital pins on the Mega can be utilized as an input or output, using
pin Mode, digital Write, and digital Read functions. They operate at 5 volts. Every pin
will be provide or receive a maximum of 40 mA and has an internal pull-up resistor
(disconnected by default) of 20-50 ohms. Additionally, some pins have specialized
functions.

» Serial:Serial 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial
data. These pins are connected to the corresponding pins of the ATmega328 USB-to-TTL
Serial chip.

» External Interrupts:2 and 3. These pins can be configured to trigger an interrupt on a
low value, a rising or falling edge, or a change in value.

* PWM:3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analog Write()
function.

* SPI1:10 (SS), 11 (MOSI), 12 (MIS0), 13 (SCK). These pins support SPI
communication using the SPI library.

e LED:There is a built-in LED connected to digital pin 13. When the pin is HIGH value,
the LED is on, when the pin is LOW, it's off.

*12C 20 (SDA) and 21 (SCL):The ATmega328 additionally supports 12C (TWI) and
SPI communication. The Arduino Software (IDE) includes a Wire library to simplify use
of the 12C bus.

There are a couple of other pins on the board

* AREF:The reference voltage for the simple sources of info (analog Inputs). Utilized
with simple Reference.

* Reset:Bring this line LOW to reset the microcontroller. Normally used to add a reset
button to shields which block the one on the board.

Memory:The ATmega328 has 32 KB of flash memory for storing code (of which 0.5
KB is utilized for the boot loader), 2 KB of SRAM and 1 KB of EEPROM (which will be
read and written with the EEPROM library).
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3.5 DESCRIPTION OF RELAY MODULE

The Relay is an attraction switch operated by a comparatively very little physical
phenomenon that is ready to activate or off away larger current. The middle of a relay is
anmagnet (a coil of wire that becomes a transitory magnet once electricity flows through
it).we tend to able to suppose a relay as a form of electrical lever switch it on with asmall
amount current and it switches on ("leverages™) another appliance using a heapof larger
current. Why is that useful? Because the name suggests, many sensors unit
ofmeasurement implausibly sensitive things of kit and switch out alone little electrical
currents. However, we'd like them to drive larger things of kit that use larger currents.
Relays bridge the gap, creating it potential for tiny currents to activate larger ones.
Which implies relays can work either as switches (turning things on and off) or as

amplifiers (converting little currents into larger ones).

Fig 3.4 Relay
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3.5.1 BASIC WORKING PROCEDURE OF RELAYS
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Fig 3.4.1 Construction of relay.

The diagram shows associate inner section diagram of a relay. Associate iron core is
enclosed by a sway coil. As shown, the ability supply is given to the magnet through a
sway switch and thru contacts to the load. Once current starts flowing through the
management coil, the magnet starts energizing and therefore intensifies the magnetic flux.
Therefore the higher wiper arm starts to be interested in the lower mounted arm and
therefore closes the contacts inflicting a brief circuit for the ability to the load. On the
opposite hand, if the relay was already de-energized once the contacts are closed, then the
contact move oppositely and build a circuit. As shortly because the coil current is off, the
movable coil goes to become back by a drive to its initial position. This force goes to be
nearly up to zero.5 the strength of the magnetic attraction. This force is principally
provided by a pair of factors. They’re the spring and put together gravity. Relays are
within the main created for two basic operations. One is low voltage application and
therefore the distinction is high voltage. For low voltage applications, extra preference
goes to lean to scale back the noise of the complete circuit. For prime voltage
applications, they are within the main designed to chop back a development referred to as

arcing.
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3.5.2 ARDUINO RELAY MODULE

Fig3.4.2 ArduinoRelay Module.

The relay module is an electrically operated switch that permits us to turn on or off a
circuit using voltage or current a lot of more than a microcontroller might handle. There is
no connection between the low voltage circuit operated by the microcontroller and also
the high power circuit. The relay protects each circuit from each other. The relay protects
every circuit from one another. Every channel within the module has three connections
named NC (normally closed), COM, and NO (normally open). Depending on the input
signal trigger mode, the jumper cap is placed at a high-level effective mode that ‘closes’
the normally open (NO) switch at high-level input and at a low-level effective mode that

operates a similar however at low-level input.

3.5.3 FEATURES OF 4 CHANNEL 5V RELAY

e Size: 75mm (Length) * 55mm (Width) * 19.3mm (Height)

e \Weight: 61g

e PCB Color: Blue

e There are four fixed screw holes at each corner of the board, easy to install and

e fix. The diameter of the hole is 3.1mm

e High-quality Single relay is used with single pole double throw, a common
terminal, a normally open terminal, and a normally closed terminal

e Optical coupling isolation, good anti-interference.

e VCC is a system power source, and JD_VCC is a relay power source. Ship 5V
relay by default. Plug jumper cap to use

e The maximum output of the relay: DC 30V/10A, AC 250V/10A
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3.5.4 PIN CONFIGURATION OF RELAY
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Fig 3.4.3 Pin configuration of relay module.
1.VCC5V DC
3. IN1 low/high output
3. IN2 low/high output
4. IN3 low/high output
5. IN4 low / high output
6. GND (Ground)
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3.6 BASIC ARDUINO SOFTWARE

ARDUINO

AN OPEN PROJECT WRITTEN, DEBUGGED,
AND SUPPORTED BY ARDUINO.CC AND
THE ARDUINO COMMUNITY WORLDWIDE

LEARN MORE ABOUT THE CONTRIBUTORS
OF ARDUINO.CC on arduino.cc/credits

Fig 3.5 Arduino Software.

The Arduino software is published as open source tools, available for extension by
experienced programmers. The language may be distended through C++ libraries, and
people needing to perceive the technical details will build the leap from Arduino to the
AVR C programming language on which it's based. Similarly, we can add AVR-C code
directly into  our  Arduino  programs  that it's  primarily  based.
The Arduino Integrated Development Environment - or Arduino Software package (IDE)
- contains a text editor for writing code, a message space, a text console, a toolbar with
buttons for common functions and a series of menus. It connects to the Arduino and real
hardware to transfer programs and communicate with them. Programs are written utilized
Arduino Software (IDE) are known as sketches. These sketches are written text editor and
are saved with the file extension .ino. The editor has options for cutting/pasting and for
searching/replacing text. The message area gives feedback whereas saving and exporting
and conjointly displays errors. The console displays text output by the Arduino software
(IDE), together with complete error messages and alternative info. The bottom right-hand
corner of the window displays the organized board and port. The toolbar buttons allow us
to verify and transfer programs, create, open, and save sketches, and open the serial

monitor.
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3.6.1 Features of Arduino Software

File

e Edit
e Sketch
e Tools

e Help

Sketch book

The Arduino Software (IDE) uses the concept of a sketchbook a standard place to store
our programs (or sketches). The sketches in our sketchbook can be opened from the File
> Sketchbook menu or from the Open button on the toolbar. The first time we run the
Arduino software, it will automatically create a directory for our sketchbook. We can
view or change the location of the sketchbook location from with the Preferences dialog.
Beginning with version 1.0, files are saved with an .ino file extension. Previous versions
use the .pde extension. We may still open .pde named files in version 1.0 and later, the

software will automatically rename the extension to .ino.

Tabs, Multiple Files, and Compilation
Allows we to manage sketches with more than one file (each of which appears in its own
tab). These can be normal Arduino code files (no visible extension), C files (.c extension),

C++ files (.cpp), or header files (.h).

Uploading

Before uploading our sketch, we need to select the correct items from the Tools >
Board and Tools > Port menus. The boards are described below. On the Mac, the serial
port is probably something like /dev/tty.usbmodem241 (for a Uno or Mega2560 or
Leonardo) or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board),
or /dev/tty. USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-
Serial adapter). On Windows, it's probably COM1 or COM2 (for a serial board)
or COM4, COM5, COMY7, or higher (for a USB board) - to find out, we look for USB

serial device in the port section of the Windows Device Manager. On Linux, Once we've
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selected the correct serial port and board, press the upload button in the toolbar or select
the Upload item from the Sketch menu. Current Arduino boards will reset automatically
and begin the upload. With older boards (pre-Decimal) that lack auto-reset, we'll need to
press the reset button on the board just before starting the upload. On most boards, we'll
see the RX and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE)
will display a message when the upload is complete, or show an error. Whenwe upload a
sketch, we're using the Arduino boot loader, a small program that has been loaded on to
the microcontroller on our board. It allows us to upload code without using any additional
hardware. The boot loader is active for a few seconds when the board resets; then it starts
whichever sketch was most recently uploaded to the microcontroller. The boot loader will
blink the on-board (pin 13) LED when it starts (i.e. when the board resets).

Libraries

Libraries provide extra functionality for use in sketches, e.g. working with hardware or
manipulating data. To use a library in a sketch, select it from the Sketch > Import
Library menu. This will insert one or more #include statements at the top of the sketch
and compile the library with our sketch. Because libraries are uploaded to the board with
our sketch, they increase the amount of space it takes up. If a sketch no longer needs a
library, simply delete its #includestatements from the top of our code.Some libraries are
included with the Arduino software. Others can be downloaded from a variety of sources
or through the Library Manager. Starting with version 1.0.5 of the IDE, we do can import

a library from a zip file and use it in an open sketch.

Third-Party Hardware

Support for third-party hardware can be added to the hardware directory of our
sketchbook directory. Platforms installed there may include board definitions (which
appear in the board menu), core libraries, boot loaders, and programmer definitions. To
install, create the hardware directory, then unzip the third-party platform into its own sub-
directory. (Don't use "Arduino" as the sub-directory name or we'll override the built-in

Arduino platform.) To uninstall, simply delete its directory.
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Serial Monitor

Displays serial data being sent from the Arduino or Genuino board (USB or serial board).
To send data to the board, enter text and click on the "send™ button or press enter. Choose
the baud rate from the drop-down that matches the rate passed to Serial. Begin in our
sketch. Note that on Windows, Mac or Linux, the Arduino or Genuino board will reset
(rerun our sketch execution to the beginning) when we connect with the serial monitor.

We can also talk to the board from Processing, Flash, MaxMSP, etc.

Preferences
Some preferences can be set in the preferences dialog (found under the Arduino menu on
the Mac, or File on Windows and Linux). The rest can be found in the preferences file,

whose location is shown in the preference dialog.

3.7 DESCRIPTION OF LCD DISPLAY 16X2

A  liquid  crystal display (LCD) could be athin, flat display
device created from any range of color or monochrome pixels arrayed ahead of a
light supply or reflector. every pixel consists of a column of liquid molecules
suspended between 2 clear electrodes, and 2 polarizing filters, the axes of polarity of
which are perpendicular to each other. LCD display is not enabled, data lines are tri-state
and they do not interfere with the operation of the microcontroller. Data can be placed at

any location on the LCD. For 16x2 LCD, the address locations are

POSITICON 1 2 3 <

o
@
-
o]
©

10 11 12 |12 114 |15

16

ADDRESS LIMNEA o0 o1 0z 103 o4 o5 |0 |OF |40 |41 42 142 |44 145 |46

Table 3.3 Address locations for a 1x16 line LCD
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3.7.1 SHAPE AND SIZES

Even restricted to character-based modules, there's still a good style of shapes and sizes
on the market. Line lengths of 8, 16,20,24,32 and 40 characters are all standard, in one,

two and four line versions.

Fig 3.6 LCD Different Models.

Totally different LC technologies exist. “Supertwist” types, for example, offer improved
contrast and viewing angle over the older “twisted nematic” types. Some modules are on
the market with backlighting, in order that they'll be viewed in dimly-lit conditions. The
rear lighting is also either “electro-luminescent”, requiring a high voltage electrical

converter circuit, or easy LED illumination.

3.7.2 PIN DESCRIPTION

Most of the LCDs with 1 controller has 14 Pins and LCDs with 2 controller has 16 Pins

(two extra pins in each for back-light LCD connections).

i e s|
a0 | M E RwW RS
321558 —
10 Das
_3 Oe= = = =
=l DB
el w1 =T Wdd Wo Wss
=2 = 4
.
=]

Fig 3.7 Pin Diagram of 16x2 line LCD.
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GND Power Supply(GND)

Vce Power Supply(+5V)
Vo Contrast Adjust
RS Instruction/Data Register Select
RW Data Bus Line
E Enable
DB0-DB7 8-bit data pins
A Power supply for LED (+)
K Power supply for LED (-)

Table 3.4 Pin Description of LCD
3.7.3 CONTROL LINES

EN:Line is named "Enable.” This control line is used to inform the LCD that you are
sending it information. To send information to the LCD, our program should make sure
this line is low (0) and then set the other two control lines and/or place information on the
data bus. Once the opposite lines are fully prepared, bring EN high (1) and sit up for the
minimum quantity of time needed by the LCD datasheet (this varies from LCD to LCD),
and end by bringing it low (0) again.

RS:Line is named "Register Select” line. When RS is low (0), the data is to be treated as a
command or special instruction (such as clear screen, position cursor, etc.). When RS is
high (1), the data being sent is text data which should be displayed on the screen. For

example, to display the letter "T" on the screen you would set RS high.

RW:Line is named "Read/Write" control line. When RW is low (0), the information on
the data bus is being written to the LCD. When RW is high (1), the program is effectively
querying (or reading) the LCD. Only one instruction ("Get LCD status"™) is a read
command. All others are write commands, so RW will almost always be low.Finally, the

data bus consists of 4 or 8 lines (depending on the mode of operation selected by the
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user). In the case of an 8-bit data bus, the lines are referred to as DB0, DB1, DB2, DB3,
DB4, DB5, DB6, and DBY7.

3.7.4INITIALIZATION AND INSTRUCTIONS

¢ P ON )
|, Power )
e '

‘Wait 15 ms or more
after Wpp reaches 4.5V

RS R/W DB7 DB DBs DB4 DBa DB, DBy DBg {

Busy flag can't be checked before execufion of this
instruction
Function Set (2-Bit Interface)

oo 00 1 1 = » = =

Wait 4.1 ms or more

Busy flag can't be checked before execufion of this
instruction
Function Set (2-Bit Interface)

oo o0 o0 1 1 = *= = =

RS R/W DB; DB, DBs DB, DB, DB, DB, DB {

Wait 100 ps or more

Busy flag can't be checked before execution of this
instruction
Function Set (28-Bit Interface)

oo o0 o 1 1 = = = =

RS R/W DB; DB DBs DB4 DB, DB, DB, DBy {

are completed. If the busy flag is not going to be checked,
then a wait time longer than the total execution time of

‘ (a) Busy flag can be checked after the following instructions
these instructions is required (See Table 7.)

RS R/W DB; DB, DBs DB4 DB, DB, DB, DB,

a0 o 0o 1 1T N F = = Function Set 2-Bit Interface, Caution: At this point,
. Single/Dual Line the display format

oo 0D 0 0 0 1 0 0 O Display Off Display, Display Font / an't he changad

o ¢ o ¢ o 0 °0 0 0 1 Display Clear

o ¢ 0o ¢ ©0 0 0O 1 VWD S Entry Mode Set

End of Initialization

Fig 3.8. Flow Chart of Installation

If the power conditions for the normal operation of the internal reset circuit don't seem to
be glad, then executing a series of instructions must initialize LCD unit. The procedure

for this initialization method is as above show.
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3.8WIRES

Fig 3.9(a) Female to Male Jumper Wire. Fig 3.9(b) Male to Male jumper wire.

In this project we need couples of Female to Male and Male to Male jumper wire. That is

for connecting Bluetooth module and relay module to the ArduinoUNO board.

Fig 3.9.1 220v carried wire.

And we need some 220v carried wire to connect load in the relay module.
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3.9POWER SUPPLY

An AC adapter, AC/DC adapter, or AC/DC converter is a type of external power supply,
typically enclosed during a case like to an AC plug. In the power supply section, we use
one step down transformer to step down the voltage from 220-volt ac to 9-volt dc. The
output of the transformer is further connected to the two diode circuit. Here two diode
work as a full wave rectifier circuit. The output of the full wave rectifier is now filtered
by the capacitor. Capacitor converts the pulsating dc into smooth dc with the help of
charging and discharging effect. The output of the capacitor is now regulated by the IC
7805 regulator. 1C 7805 provides a 5-volt regulation to the circuit and provides a
regulated 5-volt power supply. The output of the regulator is currently once more filter by
the capacitor. In the output of the capacitor, we use one resistor and one led in series to

produce a visible indication to the circuit.

—
o
o
3

w
e
<
=
o

o

Fig 3.10 12V Power supply.
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3.10LOADS

Bulbs are connected as a load. We are using three bulbs and one socket for charging or
plug in any ac device to define how to control appliances like fan, TV switch, Door lock,
Main Switch etc.This is not a fixed load, it can be vary in different places and different

areas of use.

OO HUAWEI NOVa 3e
DUAL CAMERA

Fig 3.11 Loads
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3.11COST ANALYSIS

In this section we will show cost of our project that means cost sheet representation of our
project.

3.11.1 COST SHEET

No Component Name Quantity Purchase Price
TK
01 Bluetooth Module(HC-05) 1 350.00
02 ArduinoUNO 1 400.00
03 4 Channel 5V Relay Module 1 400.00
06 Arduino voice app 1 Free
07 Power Supply 1 350.00
08 Arduino Software 1 Free
09 Breadboard 1 50.00
10 Wires 100.00
11 Bulbs with holders 300.00
Total Cost =1950.00

Table 3.5 Cost Sheet
Comparison
Our all components are available in market. We get all components are very reasonable

price. So that we make this project more cost efficient.

3.12CONCLUSION

Five main Component & some tools are used in this system to makes it .This Project is
used to control the house appliances. Our all component are very simple &available in

our country market.
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CHAPTER 4

SOFTWARE ANALYSIS

4.1 INTRODUCTION

In this chapter the software system used and also the language within which the program
code is outlined is mentioned and also the program code dumping tools are explained.
The chapter conjointly documents the development of the program for the application.

4.2 DESCRIPTION OF OUR SOFTWARE

The Arduino is open source environment makes it simple to write, re-write the code and
upload it to the INPUT/OUTPUT board. It runs on Windows, Mac OS X, and Linux. The
setting is written in Java and based on Processing, avr-gcc, and different open source

software. The screen shot of Arduinol.6.8 is shown below...

22 sketch_octO7a | Arduino 1.8.5 — — =
File Edit Sketch Tools Help

sketch_octO7a

wviodd setup () I

Sy put your setup code here, to rran

}

wold loop () {

Y Pput yvour main code here,

Fig. 4.1 Software Platform
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It is conjointly capable of collecting and uploading programs to the board with a single
click. There’s usually no need to edit build files or run programs on a command-line
interface. Although building on command-line is possible if needed with some third-party
tools such as Ino.TheArduino IDE comes with a C/C++ library known as "Wiring" (from
the project of the same name), that makes several common input/output operations much
easier. Arduino programs are written in C/C++, although users only needed define two

functions to make a runnable program
setup() — a function run once at the beginning of a program that can initialize settings
loop() — a function known as repeatedly till the board power off

The compiled window of our code is shown below.

sketch_jan14a | Arduino 1.5.3-Intel.1.0.4

File Edit Sketch Tools Help

sketch_janlda
o1d setup() 1 .

h

vo1d loop() {

ALl K

intel® Edson on fdewthehCk0

Fig. 4.2 Compiling window
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4. 3FLOW CHART DIAGRAM

Power ON

A 4
ARDUNIO UNO...OK

BLUETOOTH
MODLE.OK

BLUETOOTH
MODULE = LOW

Yes

[ TURN ON LIGHT

v
[ TURN OFF LIGHT ]

Fig. 4.3 Flow chart of our system
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4. 4CONCLUSION

The system software system developed in Embedded C, C++ language that has the
flexibility to receive the information from the sensing element and sending the
information, and controls all the appliances that connected. As a result of its low power
consumption, easy usage, reliability it's used in different fields. Software analysis is a
very important a part of our system. A software analysis makes the sure sensible design.
A proper software analysis and its burn into ArduinoUNO the project to a smooth end.
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CHAPTER 5
HARDWARE IMLEMENTATION

5.1INTRODUCTION

This is one of the most important chapters of this report. In this chapter we will show our
completed project outlook that meansConnection law &operation representation of our
project.We will discuss about component’s interfacing with ArduinoUNO of our system.

5.2INTERFACING OF BLUETOOTH (HC-05)

Module HC-05 is connected with Arduino, by attaching its one Data pin DO and D1 with
respectively and Module HC-05 operates on 5 volts.

o ARDUINO + i, oo LRI

. .
z - .‘n
l;lo||||||0||@+ eecoee .
. el i
. @:: m H
lld

]
RESET Ve o | | ‘ HHH

-ARDULINO.

Fig. 5.1Interfacing Of HC-05.
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5.3INTERFACING WITH APPLICATION

® 85 b & PR % wd i
€ Bluetooth i
Pair with HC05-Test?
0])] o
Paired devices
. . o d ey r1234
|:| PIN cantains letters or symbals
A lobleslvions You may alse need to type this PIN on the
other device
% HOO5Test otner device

M Allow HC|:_|5-Te$t 1o access your contacts

Mexus 5 is visible to nearby devices while Bluetoath CANCEL QK
settings Is apen.

Fig 5.2(a) Interfacing with Application.

At first, we need to unlock your smartphone, The we need to turn ON our Bluetooth in
the setting option. Then we need to connect our HC-05 with our smartphone. if any
password or pin is asked for pair then we need to dial "1234" as like Fig 5.2(a). Then we
need to open our Android application. Go to settings option and press connect robot as
like Fig 5.2(a). then we see our device is connected with our Android application. now we
are ready to use our device. if we want to connect a new smartphone then we need to

disconnect our paired device and then we can connect our new device.

VOICE CONTROL
TERMINAL
C ®
HEH L - ) Turn OFF
ATy >
m’g .))) how to sala or
1l2)3fafsielzlslo]o
qwertyuiop
Tum OFF
TIMER alsjdiflolhlijk]!
/N =
25 Ston A SHzixjclvibln]mig
=)

Fig 5.2(b) Interfacing of Application

After pairing we need to connect the Bluetooth with voice app, we need to give voice
commend to control the project, as example light (ON/OFF), TV (ON/OFF).

©Daffodil International University



5.4INTERFACING WITH RELAY MODULE

The below figure shows that how to connect a relay module with the ArduinoUNO

SONGLE

- O N .
o

104 B0KC 100 TSI
(10 300C 14 200
- SRODSVDCSLC

SONGLE

UNOD

KI\
&)
10 Z50NAC WA 129
1 30RC 1A 200K

- SRS

SONGLE

- D
™
x Arduino

1A ZONC 1A 15K
104 300C 1A 200C
- SRD-0VDCSLC

SONGLE

o~

@)

A 5ONC WA 125U

104 30RC 108 28C

- SRS

¥ 4 Relay Module .

Fig 5.3 Interfacing with Relay.

Relay Module have 5pins. 1 pin is for deliver through the Arduino board and 4 other pins
for 4 channel 5V relay module. In this project we are using four relays for switching the
connected three devices. We are use only the four pin. That pins are the output of our

project. As per code we use the four pins D4, D5, D6 and D7 in the Arduino Board.

Page 37 of 60
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5.5LOADS INTERFACING

9880 2 1 e

ROGIOCSL

DR . I 1 D
satee ROIVC L

.

L e e em—— .LRDC'?}‘"D(_R‘L

SOOVOCR L

A Relay Madule

n.

AA Batrery _."
Asaneq vy

Fig 5.4 Interfacing with Loads.

The loads are connected to relay module. In this project we are using three loads as per
example. There are three pins in each relay. NC (Normally Close), NO (Normally Open),
and Common pin. All the common pins are going to line voltage (220v AC) negative side
and all the neutrals of the loads go to positive side of line voltage. A wire is connected to

NO pin to loads negative side.
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5.6SYSTEM OPERATION

The base of the system is ATmega328. The Android App is acts as a remote. In the
homework, we often use TV, AC, remotes. The apps are also like the remote. The inputs
given to the microchip are the outputs of module HC-05. The module receives data from
the app. The outputs of the controller are given to the relay module. The Output of
Bluetooth module is given to the DO, D1 pin of ATmega328. When the microcontroller
receives output from the HC-05, it gives a command to operate the relay module. The
receiving and transmitter pins of Bluetooth module are connected to the TX and RX pins
of ATmega328p respectively. For the protection circuitry exhaust fan is provided with a

controller.

5.7/CONCLUSION

To design, interfacing with Arduino UNO of the circuit is that the basic purpose of our
project. Our Project work is already accomplished. The created circuit is incredibly

working.
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CHAPTER 6
RESULTS AND DISCUSSIONS

6.1 INTRODUCTION

The system projected consists of 4 major modules particularly, Bluetooth module, Relay
module with the microcontroller, Android apps. It uses ATmage328 that is an 8-bit
microcontroller. It finds wide application because of its features and low power. During

this chapter, we are going to discuss the tests our project.
6.2 EXPERIMENTAL SETUP

ATmega328 is the base of the system. The inputs given to the microchip are the outputs
of module HC-05.The output of the controller are given to the relay module. The Output
of Bluetooth module is given to the DO, D1 pin of ATmega328.

Oo HUAWEI NOVa 3e
DUAL CAMERA

Fig 6.1 Our Project
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Fig 6.1.1 Setup of our system

We will connect out Bluetooth TX pin in RX pin, and RX pin in TX pin at ATmega328
6.3RESULT

Voice control home automation system is proposed and when the power ison, the relay
switching the first light on and all are rest. Then we setup our communication with
Android phone and given voice command to execute our controlled system by preset data.
Overall system was designed and tested by introducing the home appliances controlling
wirelessly. And the wireless system is possible by Bluetooth Module. Our project is
completed a successful implementation & testing. It can be seen that output clearly. So

we said that our system was effective fast response most secure and easy to construct.
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6.4 ADVANTAGES

= |tis very easy to use.

= No additional coaching is needed for using it.

= All the control would be in your hands by using this voice control home
automation system.

= This project will give the ability of observation all the appliances with within the
communication limit through Bluetooth.

= By using this method the users will check the standing of the appliances at no

matter time of the day.

6.5LIMITATION

= Bluetooth technology utilizes in this home automation system, which has a rage
ten to twenty meters so the control cannot be achieved from outside this compass.

= Application is connected after disconnecting of the Bluetooth.

= |f we use voice technology ofttimes, we could expertise some physical discomfort

and vocal issues.

6.6 CONCLUSION

We tested our system & it’s worked properly. As beginning of the code section we use
unit testing. When we made our modules we test it by unit testing. After complete
development process of our full system, we test it by integration testing system. In every
test section we found some problems and we solve those problems as soon as possible.
After completing all process including testing we are assuring that it’s ready for home and

commercial use.
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CHAPTER 7
CONCLUSION

7.1 CONCLUSION

This project is microcontroller based mostly project. A Voice Control Home Automation
system is extremely effective during this time. During this project we wish execute the
system to be used in varied places like home appliances, industrial automation etc. A
Bluetooth module receives data through an Android apps like “Bro’s home automation”.
The data of Bluetooth module delivers to the ArduinoUNO board. ArduinoUNO controls
the switches of relay module. All the loads are connected to the relay. We have finally
succeeded in creating the “Voice Control Home Automation” Satisfactorily. More of}
information is gained and a lot of experiences are faced lot of information’s are collected
ultimately, we've concluded with an excellent pleasure for achieving our aim. We’ve
planned to satisfy my technical requirements. The knowledge we've earned with this

project really would follow until the end of our career.

7.2 APPLICATIONS

= Applications are uses as remote control.

= This project used as security system in applications like homes, hostels, industries.
= We are used to be lazy and creative, the automation system works for us.

= For safety from main line plug-in, out.

= Children do not get any electric shock.

= Protection from all kind of human hazard.
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7.3 LIMITATIONS OF WORK

Bluetooth could be a short-range wireless data network originally planned as an alternate
to the untidy tangle of add-on wires. The Bluetooth 4.0 Low Energy standard, at 26
megabits per second, is far quicker than Bluetooth used to supply and suitable for
infrequent syncing and tiny backup operations. Though Bluetooth is associate energy-
efficient technology, it will slowly drain the battery of your mobile phone or another
mobile device. Once enabled, Bluetooth frequently scans for signals, searching for new

devices to connect with, however using energy in the method.

7 AFUTURE WORK

This monitoring system will be more increased by using Bluetooth, which supports
another period of time application. For industrial purposes, a mobile robot can be
developed for automation. Within the future, all the devices that we tend to use on a daily
basis that are connected to a microcontroller {and we tend to and that we} shall use them
wirelessly not only Bluetooth control however conjointly we use approaching
technologies. Within the coming back generation use of mechanical parts and advanced

alarm, the method will be more useful for utilization.
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APPENDIX A

Important Initialization & Setup-
#include <LiquidCrystal.h>
LiquidCrystallcd(A0, Al, A2, A3, A4, A5);
int light=6;

int fan=3

inttv=4;

int ac=5;

int led=8;

String voice;

inti=0;

intpos;

void setup()

{

Serial.begin(9600);
pinMode(light, OUTPUT);
pinMode(fan, OUTPUT);
pinMode(tv, OUTPUT);
pinMode(ac, OUTPUT);
pinMode(led,OUTPUT);

digitalWrite(light, LOW);
digitalwrite(fan, LOW);
digitalWrite(tv, LOW);
digitalWrite(ac, LOW);

Serial.begin(9600);

Icd.begin(16, 2);

Icd.print("VOICE ACTIVATED");
Icd.setCursor(0,1);

Icd.print("HOME AUTOMATION");

}

void loop()
{
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while (Serial.available()){ //Check if there is an available byte to read
delay(10); //Delay added to make thing stable
char ¢ = Serial.read(); //Conduct a serial read
if (c =="#') {break;} //Exit the loop when the # is detected after the word
voice += c; //Shorthand for voice = voice + ¢

}
if (voice.length() > 0){
if(voice=="*turn on light™)

{

digitalwrite(light,HIGH);
Serial.printIn("light on™);

Icd.clear();

Icd.print(" **LIGHT ON**");
¥

else if(voice=="*turn off light")
{

digitalWrite(light, LOW);
Serial.printIn("light off");

Icd.clear();

Icd.print(" **LIGHT OFF**"),
¥

else if(voice=="*turn on fan")
{

digitalWrite(fan,HIGH);

Serial.printIn("fan on");

Icd.clear();

lcd.print(" **FAN ON**");
}

else if(voice=="*turn off fan")
{

digitalWrite(fan,LOW);
Serial.printIn("fan off");

Icd.clear();

lcd.print(" **FAN OFF**");
}

else if(voice=="*turn on TV")
{
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digitalWrite(tv,HIGH);
Serial.printIn("tv on");

Icd.clear();

lcd.print(" **TV ON**");
}

else if(voice=="*turn off TV")
{

digitalWrite(tv,LOW);
Serial.printIn("tv off");

Icd.clear();

lcd.print(" **TV OFF**");
}

else if(voice=="*turn on AC")
{

digitalwWrite(ac,HIGH);
Serial.printIn("ac on");

Icd.clear();

lcd.print("**AC RUNING**");

}

else if(voice=="*turn off AC")

{
digitalWrite(ac,LOW);

Serial.printIn("ac off");

Icd.clear();

lcd.print("**AC OFF**");
}

else if(voice=="*turn on all")
{

digitalWrite(ac,HIGH);
digitalwrite(light,HIGH);
digitalWrite(fan,HIGH);
digitalWrite(tv,HIGH);
Serial.printIn("all on");
Icd.clear();
lcd.print(" **ALL ON**");
}

else if(voice=="*turn off all")
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{
digitalWrite(ac,LOW);
digitalWrite(light, LOW);
digitalWrite(fan,LOW);
digitalWrite(tv,LOW);
Serial.printIn("all off");
Icd.clear();

lcd.print(" **ALL OFF**");

}
digitalWrite(led,1);
delay(100);
digitalWrite(led,0);
delay(100);
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